
Teacher Guide

Lessons for Middle & High School Students: Grades 6 - 9 

Technology Course using 

Microsoft Word
Produce a fan club newsletter.

In this course, students create a fan club newsletter. They design a professional-looking 

publication using Word. Students learn valuable word processing skills such as formatting text, 

arranging objects, adjusting page layout, working with tables, referencing information sources, 

and inserting headers or footers. Challenging enrichment activities support learning with 

optional assignments that explain how to create a collage, provide writing ideas, and teach 

constructive commenting. 

Copyright © 1993 – 2024 TechnoKids Inc. 

All Rights Reserved 

This is a preview. The number of pages is limited. Some pages are omitted. 

TechnoNewsletter is available for Docs and Word. 

https://www.technokids.com/store/middle-school/technonewsletter/microsoft-word-lesson-plans.aspx 



  Contents 

Copyright © TechnoKids Inc.  TechnoNewsletter | Microsoft 365 

Table of Contents 
Introduction 

Introduction ............................................................................................................................................................... i 
TechnoNewsletter Overview .................................................................................................................................. ii 
TechnoNewsletter Course Outline ........................................................................................................................ iii 
Technology Integration Ideas ............................................................................................................................... iv 

Session 1 Create a Fan Club 

Session 1 Create a Fan Club .................................................................................................................................. 1 
Assignment 1 FANtastic Newsletter........................................................................................................................ 2 

Open the Fan Newsletter Sample .................................................................................................................. 2 
Study the Fan Newsletter Sample ................................................................................................................... 2 

Assignment 2 Start a Fan Club ............................................................................................................................... 4 
Get Organized .................................................................................................................................................. 4 
Complete the Article Titles to Develop Ideas Fans Will Find Interesting ...................................................... 4 
Generate a List of Terminology Related to Your Topic ................................................................................. 5 
List Quotes that Connect with Fans ................................................................................................................ 5 
Find Websites Related to Your Topic that Fans Will Love.............................................................................. 5 
Collect Pictures ................................................................................................................................................. 5 

Session 1 Extension Activity: How to Save Pictures ............................................................................................... 6 

Session 2 Design a Newsletter Cover 

Session 2 Design a Newsletter Cover ..................................................................................................................... 7 
Assignment 3 Create the Front Cover – Phase 1 .................................................................................................. 8 

Open Microsoft Word and Create a Document .......................................................................................... 8 
Zoom to View the Full Page ............................................................................................................................ 8 
Add a Newsletter Title ...................................................................................................................................... 8 
Format the Title Font ......................................................................................................................................... 8 
Format the Title Font Size ................................................................................................................................. 9 
Change the Case of the Letters ..................................................................................................................... 9 
Format the Font Style ....................................................................................................................................... 9 
Apply Text Effects ........................................................................................................................................... 10 
Use the Text Highlight Color ........................................................................................................................... 10 
Format the Color ............................................................................................................................................ 10 
Align the Newsletter Title................................................................................................................................ 11 
Create a Bulleted List of Newsletter Articles ................................................................................................ 11 
Indent the List of Newsletter Articles ............................................................................................................. 12 
Adjust the Line Spacing ................................................................................................................................. 12 
Use Skills to Format the Text ........................................................................................................................... 12 
Save the Document and Exit Word .............................................................................................................. 12 

Assignment 4 Create the Front Cover – Phase 2 ................................................................................................ 13 
Open Newsletter in Word .............................................................................................................................. 13 
Insert a Picture onto the Front Cover ........................................................................................................... 13 
Align the Picture on the Page ....................................................................................................................... 13 
Change the Text Wrap .................................................................................................................................. 14 
Adjust the Picture ........................................................................................................................................... 14 
Apply a Picture Style ...................................................................................................................................... 15 
Arrange the Picture on the Page ................................................................................................................. 15 
Crop a Picture to Trim Unwanted Parts ........................................................................................................ 16 
Insert a Link to a Fan Website ........................................................................................................................ 16 
Front Cover Checklist ..................................................................................................................................... 17 
Save and Exit Word ........................................................................................................................................ 17 

Session 3 Top Reasons to be a Fan 

Session 3 Top Reasons to be a Fan ...................................................................................................................... 18 
Assignment 5 Top 5 List .......................................................................................................................................... 19 

Open the Newsletter in Word ....................................................................................................................... 20 



Contents 

Copyright © TechnoKids Inc. TechnoNewsletter | Microsoft 365 

Insert a Page Break ........................................................................................................................................ 20

Type an Attention-Grabbing Title on the New Page .................................................................................. 20

Introduce the Topic of the Article................................................................................................................. 20

List Interesting Facts or Insights ...................................................................................................................... 21

Automatically Add Space Before a Paragraph ......................................................................................... 21

Set Paragraph Spacing ................................................................................................................................. 21

Insert a Picture to Illustrate the Article and Crop into a Shape ................................................................. 22

Top 5 Article Checklist .................................................................................................................................... 22

Save and Exit Word ........................................................................................................................................ 22

Session 4 Build a Word Search

Session 4 Build a Word Search .............................................................................................................................. 23

Assignment 6 Design a Word Search .................................................................................................................. 24

Open the Newsletter in Word ....................................................................................................................... 24

Insert a Page Break ........................................................................................................................................ 24

Add Word Search Puzzle Title and Format It with the Mini Toolbar ........................................................... 25

Add Word Search Instructions and Adjust Paragraph Spacing ................................................................ 25

Insert a 4 x 3 Table to Hold the Search Words ............................................................................................. 25

Add Search Words into the Table ................................................................................................................. 26

Insert and Delete a Column or Row (Optional) .......................................................................................... 26

Apply a Table Style ......................................................................................................................................... 26

Make a 10 x 10 Table for the Search Grid .................................................................................................... 27

Apply Borders to the Table ............................................................................................................................ 27

Adjust the Alignment of the Cells ................................................................................................................. 27

Add the Search Words to the Grid and then Hide Them ........................................................................... 28

Word Search Checklist ................................................................................................................................... 28

Save and Exit Word ........................................................................................................................................ 28

Assignment 7 Make a Word Search Answer Key ............................................................................................... 29

Open the Newsletter in Word ....................................................................................................................... 29

Insert a Page Break ........................................................................................................................................ 29

Add Word Search Answer Key Title .............................................................................................................. 29

Copy and Paste the Word Search Grid ....................................................................................................... 29

Fill Table Cells with Color to Show the Hidden Words ................................................................................. 30

Save and Exit Word ........................................................................................................................................ 30

Session 4 Extension Activity: Keep Writing! .......................................................................................................... 31

Session 5 Write an Opinion Piece

Session 5 Write an Opinion Piece ......................................................................................................................... 33

Assignment 8 Organize Ideas for Opinion Article ............................................................................................... 34

Assignment 9 Share Your Opinion ........................................................................................................................ 36

Open the Newsletter in Word ....................................................................................................................... 37

Insert a Page Break Before the Word Search Answer Key ......................................................................... 37

Use Show/Hide to Place Cursor on the New Page ..................................................................................... 37

Type Opinion Article Title on the New Page ................................................................................................ 37

Type Introductory Paragraph ........................................................................................................................ 37

State an Opinion about the Fan Connection and Provide a Supporting Quote .................................... 38

Format the Quote – Add Quotation Marks or Indent the Block the Text .................................................. 38

Insert a Footnote for the Quote .................................................................................................................... 39

Provide More Evidence that Explains Why Fans Connect with the Topic ................................................ 39

Type Concluding Paragraph ........................................................................................................................ 40

Apply Skills to Format the Article ................................................................................................................... 40

Opinion Article Checklist ............................................................................................................................... 41

Save and Exit Word ........................................................................................................................................ 41

Session 5 Extension Activity: Create a Collage .................................................................................................. 42

Use an Online Collage Maker ....................................................................................................................... 42

Session 6 Publish the Newsletter

Session 6 Publish the Newsletter ........................................................................................................................... 43

Assignment 10 Complete the Newsletter............................................................................................................ 44



  Contents 

Copyright © TechnoKids Inc.  TechnoNewsletter | Microsoft 365 

Open the Newsletter in Word ....................................................................................................................... 44 
Replace Article Names on the Front Cover ................................................................................................ 44 
Insert a Header and Footer ........................................................................................................................... 45 
Save and Exit Word ........................................................................................................................................ 45 

Assignment 11 Share Newsletter with Readers ................................................................................................... 46 
Open the Newsletter in Word ....................................................................................................................... 46 
Option 1: Print the Newsletter ....................................................................................................................... 46 
Option 2: Save the File as a PDF and Share with Others ............................................................................ 46 
Option 3: Share the Newsletter by Email...................................................................................................... 46 
Exit any Open Programs ................................................................................................................................ 46 

Session 6 Extension Activity: Digital Citizenship & Comments ........................................................................... 47 
Commenting Advice ..................................................................................................................................... 47 
Commenting Agreement .............................................................................................................................. 48 
Write, Read, and Respond to Comments.................................................................................................... 49 

Appendices 

Appendices ........................................................................................................................................................... 52 
Appendix A: Assessment Tools ............................................................................................................................. 53 

TechnoNewsletter Skill Summary ................................................................................................................... 53 
Newsletter Marking Sheet .............................................................................................................................. 55 

Appendix B: Contact Information ....................................................................................................................... 56 
 

 

 

 



 

 

 

Introduction 

 

Introduction 

 

This section provides valuable information about teaching TechnoNewsletter. 

It includes an overview of the course. In addition, there are ideas for 

implementation and technology integration. 

 

For additional guidance, open the course in TechnoHub and select Get 

Started to access preparatory steps, resource list, and scheduling timetable. 

 

TechnoNewsletter Overview 

TechnoNewsletter Course Outline 

Technology Integration Ideas 
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TechnoNewsletter Overview 

 

In this course, students create a fan club newsletter. They design a professional-

looking publication using Word. Students learn valuable word processing skills 

such as formatting text, arranging objects, adjusting page layout, working with 

tables, referencing information sources, and inserting headers or footers. 

Challenging enrichment activities support learning with optional assignments 

that explain how to create a collage, provide writing ideas, and teach 

constructive commenting. 

 

 

Students complete the following tasks: 

 

➢ In Session 1, students organize a Fan Club. It might be for a sport team, musician, 

video game, or actor. They will design a newsletter that connects with fans. For 

inspiration, they study a sample newsletter. Next, they use a planning sheet to 

organize their ideas for each article. Afterwards, they gather resources such as 

links and images. What do fans want to know? 

➢ In Session 2, students begin to create their Fan Club newsletter. To start, they 

apply word processing skills to design a front cover. It should include eye-

catching text, a large image, and hyperlink to an official site. When complete, 

students use a checklist to examine the content and layout. 

➢ In Session 3, students write the first article for their Fan Club newsletter. It will 

include a numbered list of interesting facts or insights fans want to know. It should 

have an attention-grabbing headline such as Top 3 Reasons, 8 Secrets, or 4 Fun 

Facts. By adjusting the line and paragraph spacing students will format the text to 

make it easy to read. A task checklist guides revisions. 

➢ In Session 4, students design a word search. It will use terminology that is familiar 

to fans. Using a table, words are hidden into the cells either horizontally, vertically, 

or diagonally. The newsletter will include an answer key to the puzzle. If time 

permits, refer to the extension activity for additional article or content ideas. For 

example, students could use their word processing skills to create an ad, write a 

product review, or promote a contest that fans will love. 

➢ In Session 5, students persuade others to become fans. They write a newsletter 

article that explains the strong connection fans have with the team, group, or 

topic. It must include evidence about why they are so great, such as quotes from 

a song, book, interview, or testimonial. Using footnotes, students learn how to cite 

the source. To make the article stand out, an optional extension activity explains 

how to make a collage. 

➢ In Session 6, students share their newsletter with fans. Before they publish, they 

make final revisions to the document. This includes customizing the header and 

footer to include the name and issue number. Next, they determine how they will 

connect with readers. The file can either be printed or exported as a PDF. An 

optional activity explains how to share the file digitally to have fans add 

comments to the articles. 
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TechnoNewsletter Course Outline 

Purpose: Produce a newsletter that has a series 

of articles designed for a target audience. 

Preparation:  

• Install Microsoft 365 

• Share Newsletter folder with students 

• Prepare bulletin board materials (optional) 

• Print flashcards or tool summary (optional) 

Objectives: (see Appendix A: Skill Summary) 

• design a publication for a target audience 

• organize ideas using a planning sheet 

• write articles expressing a viewpoint 

• cite the source of information 

• revise writing to correct errors 

• share a publication in print or electronically 

• format text to make it easy to read 

• insert and format images 

• arrange text using bullets or a numbered list 

• divide content using page breaks 

• set line and paragraph spacing 

• arrange content using a table 

• copy and paste content 

• find and replace text 

• insert page numbers, headers, and footers 

 

Materials:  

• Assessment Tools (marking sheet, checklists) 

• Samples – Newsletter, Newsletter2, Newsletter3 

• Parent Letter and Certificate (optional) 

• Commenting Agreement handout (optional) 

• Commenting Bulletin Board materials (optional) 

• Word Flashcards and Tool Summary from 

TechnoHub (optional) 

• Newsletter folder 

o sample newsletters (pdf format) 

o Newsletter Planning Sheet 

o Opinion Article Planning Sheet 

  

Summary of Activities: 

• Review sample newsletters to gain ideas. 

• Generate ideas for a newsletter using a planning sheet. 

• Create a front cover for the newsletter. Format the title and arrange article names in a bulleted list. 

• Decorate the front cover by inserting a picture and hyperlink. Format image. 

• Write an article that shares insights related to the topic. Organize ideas using a numbered list. 

• Design a word search of topic-related terminology using a table to position content. 

• Produce a word search answer key by copying content and filling cells. 

• Organize ideas for an opinion piece using a planning sheet. 

• Write an opinion piece with supporting quotes. Reference quotes using footnotes. 

• Complete the newsletter by inserting page numbers, headers, and footers. 

• Print, PDF, and/or share a publication electronically. 
 

Extension Activities: 

• How to Save Pictures: Save images from Online sources. 

• Keep Writing! Write additional articles. Some ideas include contests, reviews, interview, or quiz. 

• Create a Collage: Create a collage using an Online service. 

• Digital Citizenship & Comments: Share newsletter. Read, write, and respond to comments. 

 

Assessment: 

• Self-Evaluation Checklists 

• Peer-Evaluation (Session 6 Extension Activity) 

• Teacher Evaluation (Skill Summary, Newsletter Marking Sheet) 

 

Notes: 

• If you have younger students, you may wish to substitute an activity from the Session 4 Extension 

Activity Keep Writing, for the Opinion Article. 
 

  

https://technohub.technokids.com/
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Technology Integration Ideas 

TechnoNewsletter integrates into curriculum. Your students can create a newsletter on a wide 

range of topics or for various audiences. You may wish to include course activities as part of a 

language arts, history, or science unit. Below are some suggestions: 

 

• Pop Culture: Celebrate a passion for a popular person, group, or team. It could be a 

famous actor, singer, athlete, or band. Write articles for avid fans. 

• School Newsletter: Create a school newsletter. Select a school team or club. Articles can 

be about games, activities, events, players, or coaches. 

• Novel Study Activity: Design a newsletter for a book club. Feature a novel. Write about 

the characters, define vocabulary from the text, and make connections to story events. 

• Historical Figure: Publish a newsletter for history lovers. Place the spotlight on a historical 

period or significant person. Articles can highlight important events, little known facts, 

and famous quotes.  

• Travel Destination: Showcase a location for vacationers. Write articles for interested 

travelers. Explain why the place is a "must see" and include testimonials from tourists. 

• Discovery News: Produce a newsletter for science enthusiasts. Articles can highlight issues 

or recent discoveries. Include facts from reliable sources or quotes from notable 

scientists. 

 

Understand the Big Picture 

 

Not sure where to integrate TechnoNewsletter?  

 

There are three samples provided for this course. The first sample is based on pop culture and is 

about a fictional character called TechnoStar. The second sample is of the historical figure 

Amelia Earhart. The third sample is based on the environmental issue of composting. These 

samples provide ideas on how you can include these activities into curriculum including 

language arts, social studies, history, or science. 

 



Session 1 Create a Fan Club 

Session 1 
Create a Fan Club

In this session, students organize a Fan Club. It might be for a sport team, 

musician, video game, or actor. They will design a newsletter that connects 

with fans. For inspiration, they study a sample newsletter. Next, they use a 

planning sheet to organize their ideas for each article. Afterwards, they gather 

resources such as links and images. What do fans want to know? 

Assignment 1: FANtastic Newsletter 

Assignment 2: Start a Fan Club 

Session 1 Extension Activity: How to Save Pictures 
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Start to think about your own 

newsletter. You could write 

about: 

- Pop Culture 

- School News 

- Novel Study/Book Club 

- Historical Figure/Time Period 

- Travel Location/Hometown 

- Science Discoveries/Gadgets 

Assignment 1 FANtastic Newsletter 

Who is your favorite person, group, or team? 

You are now in charge of their Fan Club! 

 

A fan club is an organization or community that people join to share 

their devotion and interest with others. 

 

You are going to publish a newsletter that connects with the fan base. 

It will include articles, word search, photo gallery, and more!  

 

To get your creativity flowing, study the sample newsletter.  

What do you like about it? What would you change? 

 

Open the Fan Newsletter Sample 

 Go to the Newsletter folder. 

 Open sample Newsletter file. 

 

Study the Fan Newsletter Sample 

 

1. The title page is what fans will see first. List the contents of the title page: 

 • newsletter title 

 • picture 

 • list of articles 

 • link to join official fan club 

 •  

 

 

 

2. View page 2. This article explains the reasons a person should go to see a concert.  
   

 a) Why would fans want to read this article? 

  

Fans may want to know more about a live performance because they want to go to 

a concert in the future. Fans may have attended a similar performance and they 

may want to compare their experience. 

   

 b) The information in the article is organized using a numbered list.  

Why is this a good way to organize information? 

  A numbered list makes it easy to read information quickly. 
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3. View page 3. The word search is made using two tables. It has words related to the 

topic. Look for some of the words. Can you find them? 
  

 Why is it a good idea to add puzzles such as a word search to a newsletter? 

 
Puzzles are fun for readers to complete. 

Puzzles offer an alternative to reading information. 

 

4. The answer key for the word search is at the end of the newsletter. 
  

 Why do you think the answer key is in this location? 

 
The answer key is at the end so that a person cannot easily look up the answers before 

completing the puzzle. 

 

5. View page 4 and 5. This article is an opinion piece that explains the connection a fan 

has with the musician.  
   

 a) What is the opinion stated in the article? 

  
The musician is an excellent role model because she does charity work and her 

lyrics have a positive message. 

 b) Quotes from song lyrics are included in the article. What makes the lyrics easy to 

read and stand out on the page? 

  
Song lyrics are single spaced and indented from the left margin to form a block of 

text. 

 

6. List the other articles or content that is included in the newsletter. 

 • collage or photo gallery 

 • header (newsletter name, issue number)  

 • footer (student name, page number) 

 

7. Who would read this newsletter? Describe the audience. For example, what are their 

interests, age range, or gender? 

  
The audience of this newsletter likes TechnoStar, pop music, 12-18 years old, and is 

likely female. 

 

 
8. Make a list of people, groups, teams, or topics you like. Circle your best idea. 

 •  •  •  

 •  •  •  

 •  •  •  

 

There are MORE sample newsletters.  
 

View Newsletter 2 to see a fan club for Amelia Earhart or 

Newsletter 3 for environmentalists. 
 

What do you like about them? What ideas do they give you? 



  Session 1 

Copyright © TechnoKids Inc. 4 TechnoNewsletter | Microsoft 365 

Assignment 2 Start a Fan Club 

You need to plan the content for your fan club newsletter.  

There are several articles that you are going to create.  

• Top 5 Article: Provide facts that readers want to know. Organize 

information using a numbered list. 

• Word Search: Design a puzzle using a table that is a grid of letters with 

hidden words. 

• Fan Connection: Write an opinion piece that states why fans connect with the person, 

group, or team. Include quotes to explain the connection. Quotes can be from a song, 

movie, book, interview, website, testimonial, or social media post. 

 

 

Get Organized 

 

1. Who or what are you picking for your fan club newsletter?   

 

2. Who would read this newsletter? Describe the audience. For example, what are their 

interests, age range, or gender? 

  

Complete the Article Titles to Develop Ideas Fans Will Find Interesting 

 

3. You are going to write an article that organizes information using a numbered list. 

Complete these titles to generate possible article ideas: 
 

 Top 3 Reasons   

   

 4 Fun Facts About  You Need to Know 

   

 10 of the Best  

   

 6 Questions About   You Want Ask 

   

 My 5 Favorite   

   

 7 Signs you Are a    Fan 

   

 8   Secrets Revealed 

 

  

It is a good idea to brainstorm ideas for your 

newsletter. This will help you to plan ahead.  

 

Answer the questions to get creativity flowing! 
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Generate a List of Terminology Related to Your Topic 

4. You are going to design a word search. Make a list of words related to your topic.

Challenge yourself! Can you think of more than ten?

•  •  •

• • • 

• • • 

• • • 

• • • 

List Quotes that Connect with Fans 

5. Why are fans devoted? You are going to write an opinion piece that states why fans

connect with the person, group, team, or topic. The article will include quotes. A quote is

a copy of words used in text or speech. The quotes can be from a song, movie, book,

interview, website, testimonial, or social media post.

Make a list of possible quotes you could use in your article. List the source.

Quote: 

source: 

Quote: 

source: 

Quote: 

source: 

Find Websites Related to Your Topic that Fans Will Love 

6. You are going to include a link to a website related to your topic.

List possible websites fans would want to visit.

http://

http://

http://

Collect Pictures 

You need pictures for your newsletter. Gather a wide range of images so that 

you will have lots of choice. Refer to Session 1 Extension Activity for instructions 

if you need help. 

7.  I have saved in my folder, seven or more pictures related to my topic. 

 I have a wide range of pictures.

IMPORTANT! You should have a wide range of ideas for your newsletter. 

If you are stuck for ideas now is the perfect time to change your topic! 



This is a preview of the teacher guide. 

Pages have been omitted. 
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Session 3 
Top Reasons to be a Fan

In this session, students write the first article for their Fan Club newsletter. It will 

include a numbered list of interesting facts or insights fans want to know. It 

should have an attention-grabbing headline such as Top 3 Reasons, 8 Secrets, 

or 4 Fun Facts. By adjusting the line and paragraph spacing students will 

format the text to make it easy to read. A task checklist guides revisions. 

Assignment 5: Top 5 List 



  Session 3 

Copyright © TechnoKids Inc. 19 TechnoNewsletter | Microsoft 365 

Assignment 5 Top 5 List 

In this assignment, you are going to write the first article for your newsletter. It 

must include interesting facts or insights that fans want to know. Information 

will be organized using a numbered list. A list chunks information so that it is 

easy for readers to scan quickly. 

 

In Assignment 2 you completed several title starters to generate possible 

article ideas. Refer to question 3 to re-read the titles. Do you like any of the 

writing ideas? Do you know lots about the topic? If yes, you are ready to get 

started. If not, think of another idea for your article. 

 

You will format your article so fans can get information fast. Here is your "To Do" list: 

 

 Insert a page break to create a new page.  

 Add the article title. 

 Write an introductory paragraph. 

 Create a list of interesting facts or insights. 

 Adjust the paragraph spacing of the article. 

 Insert a picture and crop it into a shape to decorate the page. 

 

 

 
 

 

 

 

  

Add subheadings 

that summarize each 

fact. 

Adjust paragraph 

spacing above and 

below the text. 

View newsletter 

samples for ideas. 

Pick a topic for your article 

that you know lots about! 

Article Ideas: 
 

✓ Top 3 Reasons 

✓ 4 Fun Facts 

✓ 10 of the Best 

✓ 6 Questions 

✓ My 5 Favorite 

✓ 7 Signs 

✓ 8 Secrets 
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Open the Newsletter in Word 

Insert a Page Break 

You are going to write your first article. To start, you need to make a new page. To 

do this, you must insert a page break. A page break can be used to add a blank 

page or divide content onto separate pages.  

 On the Home tab, click Show/Hide  to display formatting information. 

 Place the cursor at the END of the front cover.

or press CTRL+END to move the cursor to the end of the document.

 Click the Insert tab; click Page Break.

 Click the Home tab; click Show/Hide  to hide formatting information. 

Type an Attention-Grabbing Title on the New Page 

 Place the cursor on the new page.

On the Home tab, click Clear All Formatting  to remove any formatting. 

 On the new page, type Article Title.

Press ENTER.

 Format the font , size  , style , effects , color , and alignment . 

Introduce the Topic of the Article 

You need to introduce fans to the topic of your article. 

What is it about? 

Why do they want to read it? 

 Position the cursor below the title. You may need to press ENTER.

 Type a few sentences that describes the article to fans. Press ENTER twice.

page 1 

page 2 cursor 
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List Interesting Facts or Insights 

 Position the cursor below the introductory paragraph.

 Click Numbering.

 Type a fact or insight. Press ENTER.

 Continue to type facts or insights. Press ENTER after each one to create a numbered list.

 Press ENTER 3 times when you are done typing.

 To remove an unwanted number, click Numbering.

 Format the font , size  , style , effects , and color . 

Automatically Add Space Before a Paragraph 

 Select the list of facts.

 Click Line and Paragraph Spacing.

Pick Add Space Before Paragraph.

 Click the Layout tab. Look in the Paragrah group. 12 pt is in the Before box.

Set Paragraph Spacing 

 Select the introductory paragraph.

 From the Layout tab in the Paragraph group:

o Type 15 pt in the Before box.

o Type 15 pt in the After box.

Create a multi-level list! 

Use Increase indent  

to make an alphabetized list. 

Paragraph spacing is the amount of 

space above or below a paragraph. 

It is measured in points or pt. 

You can quickly add 12 pt of space 

before a paragraph. Try it! 
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Insert a Picture to Illustrate the Article and Crop into a Shape 

 Place the cursor on the page.

 From the Insert tab, click Insert Pictures.

 Choose Online Pictures… from the menu.

 In the search box, type a search word. Press ENTER.

 Click on a picture you like, then click Insert.

 With the picture selected, click the Picture Format tab; click the Crop  arrow. 

Click Crop to Shape.  Pick a shape.

Top 5 Article Checklist 

✓

Article Title 

The title has capital letters. 

The title grabs attention and tells about the topic of the article. 

Content 

The article is interesting to fans. 

The introductory paragraph tells about the article. 

Facts or insights are organized in a numbered list. 

There are no spelling or grammar errors. 

Design 

Text is formatted so that the article is easy to read. 

Paragraph spacing adds white space between text. 

The picture relates to the topic and is well-formatted. 

Article fits well on the page and is balanced. 

Save and Exit Word 

The article should fit on one page. Set the Zoom level to 

Whole page to see how it will look when printed on paper. 



 

 

 

Session 4 Build a Word Search 

 

Session 4 
Build a Word Search 

 

In this session, students design a word search. It will use terminology that is 

familiar to fans. Using a table, words are hidden into the cells either 

horizontally, vertically, or diagonally. The newsletter will include an answer key 

to the puzzle. If time permits, refer to the extension activity for additional article 

or content ideas. For example, students could use their word processing skills to 

create an ad, write a product review, or promote a contest that fans will love. 

 

Assignment 6: Design a Word Search 

Assignment 7: Make a Word Search Answer Key 

 

Session 4 Extension Activity: Keep Writing! 

 



This is a preview of the teacher guide. 

Pages have been omitted. 
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Session 4 Extension Activity: Keep Writing!  

Newsletters can contain many other types of articles. Keep writing! Add 

to your newsletter a variety of attention-grabbing information, advice, 

entertainment, or fun pieces that will engage and interest your readers. 

Find some ideas below. 

 

• Interview (View Newsletter 2 to see a sample) 

Make up a conversation with a person related to your newsletter. 

Interview the subject of the newsletter, a fan, a family member, a 

competitor, or someone in the same profession.  

 

• Create an Advertisement 

Think of a product that fans who read your newsletter would like to 

have. Include a picture, persuasive description, and pricing 

information. 

 

• Letter from the Editor 

Take the role of an editor. Include a photo of yourself and write a short message that 

welcomes readers to the newsletter. 

 

• Letter to the Editor 

Take the role of a reader. Comment on an imaginary article in a recent issue of the 

newsletter. Offer praise or criticism. Request an article you would like to read.  

 

• Staff Picks 

The newsletter team may recommend products, further reading, or advice. List top three 

endorsements from the employees. 

 

• Contest/Giveaway 

Promote a contest or prize that can be won. Include a convincing 

description that promotes the prize, a picture, how to enter, and 

when winners will be announced. 

 

• Up Close and Personal 

Write a short biographical article about the topic of the 

newsletter. Include facts that fans would want to know about 

lifestyle, interesting trivia, or little-known information. 

 

• In the News 

Compose a report on a recent or upcoming event. Be sure to include who, what, when, 

where, and why.  

 

• Product Review 

Write a product review about your topic. The article should include both positive and 

constructive feedback.  

 

• How To 

Write step-by-step instructions about how to complete a task related to your topic. Some 

ideas are: give advice, make a craft, create a model, cook a recipe, do a trick, offer a 

tip. 
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• Quiz (View Newsletter 3 to see a sample)

Make a trivia quiz for your readers. Title it: "How Well Do You Know

____________________?" Write a series of multiple-choice questions.

Use a footnote or endnote to create an answer key.

• Expose

Surprise or shock the reader with an anecdote, statistics, or quotes.

Reveal something about the newsletter topic that is new or not

commonly known.

• Personal Experience

Write from your own point of view and your relationship with the newsletter topic. How

did you get interested? When and why did you become a fan? Was there an event or

special experience that hooked you?

• Trends

What are the latest trends related to your topic? Is there a new look, gadget, show, or

celebrity that is 'hot'? Give a fresh, up-to-date look at what is fashionable and 'in'.

• Gather More Ideas!

Gather a collection of magazines, online or paper examples, to scan and examine the

types of articles that you could add to your newsletter.
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Newsletter Marking Sheet 

NAME:  

Content  

Publication effectively targets a specific audience. 
/2 

Front cover informs readers about the content. It includes a title, bulleted list of 

articles, image, and hyperlink. /4 

Article shares insights about a topic that is appealing to fans. It includes a title, 

introductory paragraph, and a numbered list of Information.  /10 

Word search lists topic-related terminology. It includes a title, instructions, search 

terms, and letter grid. The content is positioned using tables. /3 

Word search answer key is located at end of newsletter with all answers highlighted. 
/2 

Opinion article states a viewpoint with quotes to support argument. It includes a 

title, introduction, two paragraphs, two quotes, two footnotes, and a conclusion.  /10 

Spelling and grammar are accurate. 
/2 

Layout 

Article sections are on separate pages. 
/2 

Page design utilizes space well and attracts readers. 
/4 

Text is formatted for easy reading and to engage reader interest. 
/4 

Images are attractive, relate to the topic, and have eye-catching styles applied. 
/4 

Pages are numbered. 
/1 

Pages have appropriate headers and footers. 
/2 

Comments: 

/50 

 



 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

This course includes a sample of a completed project. 
Teachers can use this resource for demonstration purposes 

or as a source of inspiration. 
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Top 5 Reasons to Go to a Concert 

 

Just like you, I am a TechnoStar fan. I was lucky to see her perform in a concert a 
few months ago. Once you see a live performance you really appreciate her 
talent. Here are the top 5 reasons everyone should go to a TechnoStar concert. 

1. Amazing Voice: Her voice is amazing! I thought she sounded great on the 
radio. She is even better live. 

2. Dance Routines: Her backup dancers are talented. They make the show 
really fun to watch. 

3. Stunning Light Show: The light show changes for each song. There are 
patterns on the wall, laser beams around the arena, and even some 
fireworks. You won't believe your eyes! 

4. Unique Memorabilia: Before the show, vendors sold posters, t-shirts, 
mugs, key chains, and more. If you want some rare fan collectibles you 
need to go to a concert. 

5. Fantastic Fans: It is great to be in a place with so many people. Everywhere 
you look there is a fellow fan. What makes this so great? 

a. It is fun to sing along with thousands of people because we all know 
the words. 

b. It is easy to make new friends because you already know a bit about 
the person. They like pop music and TechnoStar so you have 
something in common. 

c. It is a big dance party with everyone out of their chairs moving to the 
beat.  
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Amazing TechnoStar Word Search 

Pop music fans! Can you find the hidden words about TechnoStar? 

TALENTED SINGER POP MUSIC FAMOUS 

CONCERT TECHNOSTAR DANCING ALBUM 

MICROPHONE TECHNOMUSIC WINNER PLATINUM FAN 

 

B T A L E N T E D I P K T O P N T 

F P H D S B H A B T O I E D L R C 

R K Y F A M O U S E P E C M A E I 

A I R A B I E L A L M D H O T F L 

W L F N V C B E H C U S N I I L H 

Y H B L C R R L T H S C O P N T C 

I K D U N O T A T L I T S S U Y T 

O A S P M P N U S S C L T U M T S 

P C A O I H R C R Y N E A G E C I 

L V Q U L O H X E B O S R U Y A N 

D A N C I N G Y I R O F R S W L G 

M B G L A E C O R U T C L N S E E 

T E C H N O M U S I C W I N N E R 
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Making a Difference! 
TechnoStar is one of the most popular musicians on the pop music charts. Some people think she 

is just another pretty girl that dances around on stage. That is not true. TechnoStar is an amazing 

person who brings a lot of joy to her fans. Her charity work improves the lives of others and her 

song lyrics offer inspiration to her fans. I think TechnoStar is an excellent role model for teens. 

 

TechnoStar does charity work. She sang at the TechnoHelp Concert to raise money for disaster 

relief. She also volunteers with the TechnoChildren's Society to help families in need. TechnoStar 

encourages fans to help others. In a recent Facebook post on the TechnoStar page, one fan 

wrote,  

You are amazing! I saw how you helped those families. After seeing how many kids need 

help I talked to my teacher. Our school is now raising money for a local food bank. 1 

Fans see what TechnoStar does for other people and they want to help too. 

  

                                                      
1 Post from www.facebook.com/technostar, on 01/01/2014. Comment was made under a video 

post of TechnoStar volunteering at a local food bank. 

http://www.facebook.com/technostar
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TechnoStar lyrics offer inspiration to fans. In her song, Believe in Yourself, she encourages teens to 

be confident and to like themselves. The chorus is, 

Believe in you, 

Believe me it's true. 

You have what it takes, 

Don't worry about mistakes. 

Believe.2 

 

The song reminds fans that if they believe in themselves they can achieve their goals. The dance 

beat put to these lyrics is upbeat. It makes people feel great when they listen to the song. 

 
TechnoStar is more than a singer. She is a role model for teens. Fans see how her charity work 

helps others and they want to get involved too. As well, her songs share an encouraging 

message with listeners. If you have ignored TechnoStar thinking she was just another pop star, 

take another look. She is making a positive difference! 

                                                      
2 Chorus from Believe in Yourself by TechnoStar. View the lyrics at www.technostar.com/believe. 
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Word Search Answer Key 
 

B T A L E N T E D I P K T O P N T 

F P H D S B H A B T O I E D L R C 

R K Y F A M O U S E P E C M A E I 

A I R A B I E L A L M D H O T F L 

W L F N V C B E H C U S N I I L H 

Y H B L C R R L T H S C O P N T C 

I K D U N O T A T L I T S S U Y T 

O A S P M P N U S S C L T U M T S 

P C A O I H R C R Y N E A G E C I 

L V Q U L O H X E B O S R U Y A N 

D A N C I N G Y I R O F R S W L G 

M B G L A E C O R U T C L N S E E 

T E C H N O M U S I C W I N N E R 
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